
บทท่ี 4 
เทคนิคการออกแบบส่ือดวยคอมพิวเตอร 

 
การออกแบบปายไวนิล 
 

  ปายไวนิลเปนส่ือส่ิงพิมพระบบใหมท่ีใชกนัมากในขณะนี้  เปนการออกแบบเพื่อช้ีแนะและ
ชักชวน ทางดานบริการ จากความคิดของคนๆ หนึ่งไปยังกลุมชนโดยสวนรวม ซ่ึงการ
ประชาสัมพันธเปนปจจยัสําคัญท่ีจําเปนสําหรับการดํารงชีวิตของประชาชน และธุรกิจ เพราะจะ
ชวยกระตุน หรือผลักดันอยางหนึ่งในสังคม เพื่อใหประชาชนเกดิความตองการ และเปรียบเทยีบ 
ส่ือท่ีประชาสัมพันธใชแตละอยางในการประชาสัมพันธ  เชน การโฆษณาสินคา  ปายประกาศหา
เสียง  หรือการประชาสัมพันธหลักสูตรการศึกษา  และการประชาสัมพันธท่ัวไปปายไวนิลจึงเปน
สวนหนึ่งในการประชาสัมพันธ  
 

หลักการออกแบบปายไวนิล    
 

กอนท่ีจะเร่ิมการออกแบบปายไวนิลสส่ิงแรกท่ีผูออกแบบตองคํานึงถึงก็คือ การกําหนด

จุดประสงคท่ีแนนอนของงานแตละช้ินลงไป  เพราะลูทางการนําเสนอขาวสารมีมากมาย  ซ่ึงทําให
เกิดความสับสนในการดําเนนิงานท่ีอาจจะมีการปรับปรุงเปล่ียนแปลงอยูเร่ือย ๆ ทําใหเกิดการ
ทํางานท่ีไมเปนระบบ  เกิดการสูญเสียและส้ินเปลืองปจจัยตาง ๆ โดยใชเหตุ  ดังนัน้ผูออกแบบจงึ
ควรมีหลักการและขอควรคํานึงกอนการเร่ิมงาน วาตองการรูปแบบไหน  ควรใสอะไรลงไปบาง 
โดยการวางแผนใหรัดกุม  งานจะไดสําเร็จลุลวงไปไดดวยดีจนจบส้ินกระบวนการ 

การออกแบบปายไวนิลโดยการใชโปรแกรม Adobe Illustrator 10, CS2, CS3 Adobe 
Photoshop 7,   Adobe Photoshop CS2, Adobe Photoshop CS 3 การออกแบบปายไวนิลมีสวน
สําคัญอยูดวยกัน 4 สวนหลักคือ 

1. พื้นหลัง  พืน้หลังไดแกสวนท่ีเปนพื้นหลังท้ังหมด 
2. รูปภาพ  ไดแกภาพถายและภาพกราฟค 
3. อักษร  เปนสวนของขอความตาง ๆ เชน หวัเร่ืองเดน  บอกช่ืองาน บอกสถานท่ี บอกวัน

เวลาและช่ือหนวยงานท่ีจดัทําหรือดําเนนิการ 
4. สี  การออกแบบสีควรมีความรูเร่ืองของคูสีในการออกแบบเพื่อแบบท่ีออกจะไดสวยงาม

ในท่ีนี้จะขอแนะนําใหไปดไูดท่ี http://www.google.com/  พิมพหาช่ือ killer adobe.com จะปรากฎคู
สีในการออกแบบส่ิงพิมพ  มาใหเลือกมากมายหลายคูสี 
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สีพื้น ( Fill)  เปนเหมือนกับตัวแทนการทํางานของพ้ืนผิวของวัตถุท่ีทํางานท้ังหมด ไมวาจะเปนพืน้
เฟรมของงาน เปนตน   
 
 
 
 
 
 
 
 
                                                             ภาพ  4.1 รูปสีพื้น 
 
รูปภาพ  ( Pictures) แบงไดเปน สองแบบ คือ ภาพบิทแมพถาย ท่ัวไป สวน   ภาพ เวคเตอร Vector 
เปนภาพท่ีวาดขึ้นดวยคอมพวิเตอรนั่นเอง รูปภาพเปนสวนประกอบท่ีสําคัญอันท่ีสองในการ
ออกแบบ เพือ่ดึงดูดความสนใจแสดงประกอบเร่ืองราว ใหเกิดความรูสึก ความเขาใจคลอยตาม
วัตถุประสงค 
     ภาพบิทแมพ Bitmapped graphics เปนภาพกราฟคท่ีสรางข้ึนจากการนําจุดเล็ก ๆ จํานวน
มากมารวมกนั จะส้ินเปลืองเนื้อท่ีในการจัดเก็บมาก และการขยายภาพใหใหญข้ึนจะปรากฏรอย
หยัก  
 
 
 
 
 
 
 
 
                                                         ภาพ  4.2 ภาพบิทแมพ 
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ภาพ เวคเตอร  (Vector graphics) เปนภาพกราฟคท่ีสรางข้ึนจากสมการทางคณิตศาสตร
แบบตาง ๆ ทําใหใชเนื้อท่ีในการจดัเก็บนอย และสามารถยอหรือขยายภาพโดยท่ีคุณภาพของภาพ
ไมเปล่ียนแปลงขอเสียคือ เคร่ืองตองมีการคํานวณท่ีซับซอนจึงมีการทํางานชากวาแบบบิทแมพมาก  

 
 
 
 
 
 
                                                          ภาพ  4.3 ภาพ เวคเตอร 
 
อักษร (Text)   เปนขอความออบเจ็กตชนดิหนึ่ง  ตัวอักษรหรือตัวหนงัสือคือเคร่ืองหมายท่ีใชแสดง
ความรูสึกนึกคิดเปนการเผยแพรความรูความเขาใจในความหมายไดอยางชัดเจน  ตัวอักษรหรือ
ตัวพิมพจึงจัดวาเปนองคประกอบพืน้ฐานสําคัญอันดับแรกของการออกแบบการจัดวาง  (Lay-Out 
Design)  การออกแบบจําเปนตองมีการเรียนรูเกีย่วกับตัวอักษร เชน ขนาด (Type size) รูปราง
ลักษณะ (Character) สวนประกอบตลอดจนกรรมวิธีการตาง ๆ ท่ีเกี่ยวของกับการจดัและการผลิต
ตัวอักษร เพื่อเกดิความเขาใจและการนํามาใชอยางถูกตองเหมาะสมซ่ึงสามารถดูไดจากตาราง
เปรียบเทียบขนาดอักษร 
 

ตารางการเปรียบเทียบขนาดตัวอักษรท่ีเหมาะสมกับวัยของผูอาน 

 
                       ภาพ  4.4   ตารางการเปรียบเทียบขนาดตัวอักษรท่ีเหมาะสมกับวัยของผูอาน 

อายุ ขนาดตัวอักษรโรมัน(pt.) ขนาดตัวอักษรไทย(pt.) 
5–7 
7–8–9 
10–12 
12 ปข้ึนไป 
ผูใหญปกติ 
คนสูงอายุ 60 ปข้ึนไป 
 

18 
12–14 
11–12 
11–12 
10–11–12 
11–12 
 

24–30 
18–30 
16–18 
16–18 
14–16 
 16–18 
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รูปแบบตัวอักษร การสรางสรรครูปแบบตัวอักษรใหสวยงามแปลกตา และสอดคลองกับลักษณะ
ของขอความ มีความชัดเจน ทําใหเกิดความนาสนใจมากข้ึน การสรางรูปแบบตัวอักษรทําได 2 ทาง
คือ การจินตนาการรูปแบบใหมสําหรับงานนั้นๆ โดยเฉพาะ กับ การเลือกใชอักษรสําเร็จท่ีออกแบบ
ไวเปนมาตรฐานท่ัวไป 
 

สีของตัวอักษร ในการกําหนดสีใหยึดหลัก 3 ประการ คือ 
 

1.  คําน้ําหนักของสี (Tone of Color) 
2.  สีของตัวอักษรตองไมใชหลายสีจนเกินไป 
3.  ควรใชสีใหเหมาะสมกบัคําหรือขอความนั้นๆ 

 

ตัวอยางรูปแบบอักษรภาษาไทย 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
                                                 ภาพ  4.5 รูปแบบตัวอักษร 
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ตัวอยางรูปแบบอักษรภาษาอังกฤษ 
 
 
 
 
 
 
 
 
 
 
 
 
 
                                        ภาพ  4.6 รูปแบบอักษรภาษาอังกฤษ 
 
สี  (Color)    ส่ิงแรกท่ีควรรูเกี่ยวกับเร่ืองสีก็คือ การเลือกใชโหมดสีใหเหมาะกับประเภทของงาน 
โดยจะตองมีหลักการเลือกใชโหมดสีอยางถูกตอง ตลอดจนรูขอจํากัดของสีแตละโหมดอีกดวย ซ่ึง
รายละเอียดของโหมดสีมีดังนี้ 
 

1. โหมด Bitmap คือ โหมดสีท่ีมีการเก็บขอมูลของสี 1 บิตตอพิกเชล  ซ่ึงจะแสดงผลได
เพียงสีขาวและสีดําเทานัน้ และไมมีการไลโทนสี ลักษณะภาพท่ีไดจึงมีความหยาบ 
เหมาะสําหรับภาพลายเสน 

2. โหมด Grayscale คือ เปนโหมดสีขาวดํา ท่ีสามารถไลโทนได 256 ระดบั 
3. โหมด Duotone คือ โหมดสีสําหรับภาพแบบ Monotone, Duotone โดยรูปภาพจะ

แสดงแบบ Grayscale เพียง Channel เดยีว มีคา 8 บิตตอพิกเชล 
4. โหมด RGB Color  (Red Green Blue) คือ โหมดสีท่ีมีแมสี 3 สี ไดแก แดง, เขียว, น้ํา

เงิน และแตละสีสามารถไลเฉดสีได 256  ระดับ  และเม่ือรวมกันท้ัง 3 สี จะสามารถ
แสดงสีไดถึง 16.7 ลานสี โหมดนีจ้ะเหมาะกับงานประเภทตกแตงภาพมากท่ีสุด 

5. โหมด CMYK Color คือ โหมดสีท่ีมีแมสี 4 สี ไดแก  Cyan (ฟา), Magenta (บานเย็น),  
Yellow (เหลือง),  Black (ดํา) แตละสีเก็บขอมูล 8 บิต เปนโหมดท่ีเหมาะสําหรับงานพิมพมากท่ีสุด 
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6. โหมด Lab Color  คือ โหมดสีเสมือนจริง ใชคา Lightness แทนความสวาง มีคาต้ังแต 
 0 – 100 โดยคา a แทนสีเขียวถึงสีแดง และคา b แทนสีน้ําเงิน ซ่ึงมีคา +120 ถึง -120 ใชในงานพิมพ
ระดับสูง     
 
   
 
 
 
 

 
 
 
 
                                                         

                                                  ภาพ  4.7 สี Color Picker 
 
 
 
 
 
 
 
 
 
 
 
                                                 ภาพ  4.8 สี Gradient Editor 
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เทคนิคการผลิตปายไวนิลอิงคเจ็ท  (Vinyl Inkjet) 
 

ปายไวนิลอิงคเจ็ท (Vinyl Inkjet) คือปายโฆษณาอยางหนึ่งซ่ึงมาแทนท่ีปายผานั่นเอง ปาย
ไวนิล เปนวสัดุท่ีผลิตมาจากเสนใยโพลีเอสเตอรชนิดพิเศษและเคลือบดวย PVC ท้ังสองดานมีท้ัง
ชนิด โปรงแสงสําหรับงานกลองไฟ และชนิดทึบแสงสําหรับงานโฆษณาท่ัวไป สีสดสวย ควรมอง
ระยะหาง 1 เมตร จะดูชัดเจนดี ขนาดเสนใยไวนิล ขนาด 300x500 / 18x12 /  น้ําหนัก 440 g  ตอ 
ตรม. การจัดทําไฟลอารทเวิรค 0.4 mm. ทําการขยายภาพไป เกิน 300 % แลวภาพท่ีไดแตกหรือสีท่ี
ใชเปนระบบ CMYK โหมด หากไฟลงานมาเปนระบบสีอ่ืน สีงานท่ีผลิตจริงจะเพี้ยน ความละเอียด 
300 dpi ข้ึนไป ยิ่งละเอียด ความคมชัดกจ็ะยิ่งสูง หากเปนไฟลงานท่ีมีฟอนท อยาลืม Create outline 
และ save งาน อยาลืม Include link files ไฟลงานท่ีทําเสร็จแลวควรเปนไฟล TIFF ควรตรวจปรูฟ
กอนพิมพทุกคร้ัง 

 

ขั้นตอนการผลิตปายไวนิล   (Vinyl Inkjet) 

1. เขาสูโปรแกรม Adobe Photoshop   Click Icon        บน Desktop 
2. Click ท่ีเมนู File  
3. คําส่ัง New (Ctrl + N) 
4. เกิดหนาตาง NEW   
5.กําหนดขนาดของปายไวนลิเปนเซนติเมตร เชนกําหนดขนาดเปน สูง120 cm. คูณ ยาว 
240 cm. ไปท่ี File                      New    
 

 
 
 
 
 
 
                                                      ภาพ  4.9 การเปด File 
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6.  กําหนดขนาดเปน 120 cm. คูณ 240 cm. Resolution ใหคาเปน 72  pixels / inch  กําหนด
โหมดใหเปน CMYK Color   พื้น Contends (เปน ขาว)  ใหคลิก OK 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
                                                  ภาพ  4.10 การกําหนดขนาด 
 

7.  พื้นท่ีการทาํงานขนาด 120 คูณ 240 cm. 
 
 
 
 
 
 
 
 
                                                         ภาพ  4.11 พื้นท่ีการทาํงาน 
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8.  เลือกรูปแบบตัวอักษรไปท่ี แถบเมนูบารเลือกแบบตัวอักษร 
 
 
 
 
                                                           ภาพ  4.12 กําหนดตัวอักษร 
 

9. พิมพอักษรหัวเร่ืองตามความสําคัญของงานไปท่ี Horizontal Type Tool (T)                    
กลองเคร่ืองมือพิมพ 
 
 
 
 
 
 
 
 
 
 
 
 
 
                                                         ภาพ  4.13 การพิมพตัวอักษร 
 
 

10. การใสสีในตัวอักษรทําการปายตัวอักษรแลวไปที ่ Set foreground color                    ทํา
การเลือกสีตามแบบหนังสือคูมือแลวเลือกคูสีท่ีตองการสี 
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ภาพ  4.14 การใสสีตัวอักษร 
 
11. การเลือกสีจาก Set foreground color                       ดับเบ้ิลคลิก จะได Color Picker 

ข้ึนมาใหทําการเลือกสีตามคูสีท่ีกําหนด 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพ  4.15 การเลือกสีตัวอักษร 
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12. ใสสีตามตัวอักษรจะไดคูสีตามแบบท่ีตองการ 
 
 
 
 
 
 
 
 
 
 
 

ภาพ  4.16 การเลือกสีตัวอักษร 
 

13.  การใสรูปภาพ ทําการเปดไฟลรูปภาพท่ีตองการ 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพ  4.17 การเปด File ภาพ 
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14.  โดยการ Move tool (v)                   ลากรูปภาพวางในสวนท่ีตองการ 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพ  4.18 การ move File ภาพ 
 

15. ทําการขยายภาพไปท่ี Edit                Transform                Scale 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพ  4.19 ทําการขยายภาพ 
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16.  จะไดภาพท่ีขยายตามตองการแลวกด Enter กรอบก็จะหายไป 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพ  4.20 การขยายภาพ 
 

17.  จะไดปายไวนิลท่ีสมบูรณ 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพ  4.21 ปายไวนิลท่ีสมบูรณ 
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18.  ทําการ Save File ใหไปท่ี File              Save as                   File name                Format  
ใหเปนนามสกุล TIFF                   Save 

19.  ทําการพิสูจนอักษรกอนสงโรงพิมพทุกคร้ัง 
 

ตัวอยางปายไวนิล 
 
 
 
 
 
 
 
 
ภาพ  4.22 ปายแสดงความยินดี กับนักศึกษา โดยแบงพื้นท่ีของปายเปน 2 สวน โดยใชภาพและ
ตัวอักษร ช่ือผูท่ีไดรับรางวัล คณะ ประเภทของรางวัล หนวยงานท่ีเผยแพร  

 
 
 
 
 
 
 
 
 
 
ภาพ  4.23 ปายการบรรยาย อบรม ควรมีกราฟค หัวเร่ือง ช่ือผูบรรยาย วันท่ี เวลา สถานท่ี 
ภาพประกอบ สีสัน  
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ภาพ  4.24 ปายเชิญชวน ตัวอักษร เร่ือง บรรยายโดย วนัเวลา สถานท่ี หนวยงานท่ีเผยแพร กราฟค  
อาจเปนภาพประกอบ ภาพถายก็ได 

 
 
 
 
 
 
 
 
 
 
 
 
ภาพ  4.25 ปายประกาศ โลโก หนวยงานท่ีแจงขาวสาร ป ขอความ สีสันท่ีดงูายชัดเจนบอก
รายละเอียดครบถวนวนัรับสมัครและวันหมดเขต   
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เทคนิคการออกแบบโปสเตอร (Poster) 
 

โปสเตอร  คือส่ืออยางหนึ่งท่ีบอกกลาวถึงรายละเอียดใหผูคนท่ีไดพบเห็นไดทราบ  โดยมี
จุดเดนและเขาใจไดในระยะเวลาส้ัน  ๆ  ในภาพอาจบรรจุตัวหนังสือหรือภาพ   (ท่ีมา : ประชิด  ทิณ
บุตร,  2530  หนา 136 )  เพื่อใหโปสเตอรสมบูรณ  เปนการแจงขาว ประกาศขาว ประชาสัมพันธ
ขอมูลออกสูสาธารณะชน  เพราะฉะน้ัน โปสเตอรจึงเปนงานพิมพดานเดียว (อีกดานไมพิมพ
เนื่องจากตองใชติดกาวอยูแลว) โดยขนาดของโปสเตอรนั้น ก็ข้ึนอยูกบัความตองการ โดยมีขนาด
ไซทท่ีนิยม กจ็ะเปน ขนาด A1 , A2 , A3 หรือ ขนาด 31x21 นิ้ว , 15x21 นิ้วท่ีเปนไซทลักษณะ
ดังกลาวเนื่องจากไมเสียเศษกระดาษ จึงเปนไซทท่ีคุมคาคุมราคาท่ีสุด อยางไรกต็าม ขนาดก็
ปรับเปล่ียนไปไดตามความตองการ เนื่องจาก โปสเตอร (Poster) ใชติดเพื่อประชาสัมพันธขาวสาร 
ใหคนเห็นในระยะไกลขอมูลในโปสเตอรจงึไมควรมีขนาดเล็กเกนิไป และควรมีเนื้อหาท่ีกระชับ 
ชัดเจน รัดกุม และควรจะมี โลโก เบอรโทร การติดตอเจาของงาน ดวยสุดทายขนาดของโปสเตอร 
ยิ่งใหญ ก็ยิ่งเปนท่ีดึงดูดสายตา และความสนใจ ของผูคนไดมากแตอยางไรก็ตาม ก็ตองคํานงึถึง
สถานท่ีในการติดประกาศดวย วาโปสเตอรขนาดใหญเกนิไปท่ีจะสามารถปดประกาศไดหรือไม 

 

กระดาษท่ีนิยมใชพิมพโปสเตอร(Poster)  
 

             1.อารทมัน130-160 แกรม  
             2. อารทมัน 190-310 แกรม  
              3. กระดาษปอนด 80 - 120 แกรม  
ขนาดมาตรฐานโปสเตอร (Poster) 
              29.7 x 42 cm (A3) 
              42 x 59.4 cm (A2) 
              59.4 x 84  cm (A1) 
              31.0 x 21.0  นิ้ว 
               15.5 x 21.0  นิ้ว 
 

หลักการออกแบบโปสเตอร 
 

 1.  กําหนดรูปแบบ (Form) ในการออกแบบโดยกําหนดขนาดของโปสเตอร 
 2. วิเคราะหเนือ้หา (Content) ควรใชขอความท่ีกระทัดรัดเขาใจงาย 
 3.  การกําหนดตัวอักษรในการทําปาย  ควรเปนอักษรท่ีอานงายไมควรมีลูกเลนมากนัก 
 4.  การกําหนดสี (Color)  ควรเลือกจากหนังสือคูสีเปนหลักในการกําหนดคาสี 
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 5.  การเลือกภาพจากภาพถาย  หรือรูปภาพกราฟคก็ได  แตการเลือกภาพควรใหมีขนาด
ใหญ   ภาพท่ีจะใชในการออกแบบจะไดไมแตก  
 

การใชงานประโยชนของโปสเตอร(Poster) 
 

                -   เผยแพร ขาวสาร โฆษณาประชาสัมพันธ 
 

ขั้นตอนการปฎิบัตงิาน 

1. เขาสูโปรแกรม Adobe Photoshop   Click Icon        บน Desktop 
2. Click ท่ีเมนู File  
3. คําส่ัง New (Ctrl + N) 
4. เกิดหนาตาง NEW   
5. กําหนดขนาดของโปสเตอร  เปน 100*150 cm.  
 
 
 
 
 
 
 
 
 
 
 

ภาพ  4.26  กําหนดขนาดของโปสเตอร 
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6. กําหนดพื้นสีท่ีกลองเคร่ืองมือ Set Foreground color  
 
 
 
 
 
 
 
 
 
 
 
                                     ภาพ  4. 27 กําหนดพื้นสี 
 
7. เลือกสีพื้นเปนสีดําเสร็จแลวกดปุม OK 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
                                ภาพ  4.28 เลือกสีพื้น 
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8.  เลือกรูปแบบตัวอักษรไปท่ี แถบเมนูบารเลือกแบบตัวอักษร  
 
 
 
 
                                                  ภาพ  4.29  เลือกรูปแบบตัวอักษร 

 
9. ไปท่ี Horizontal Type Tool (T)                    กลองเคร่ืองมือพิมพ ไปคลิกท่ีพื้นท่ีทํางาน

ทําการพิมพขอความตามรูปแบบท่ีกําหนดไว 
 
 
 
 
    

 
 
 
 
 
 
 
 
 

                                        ภาพ  4.30  การพมิพอักษร 
 

10. เปดไฟลภาพโลโกนาโนท่ีตองการ 
 
 
 
 
 
 

 
                                      ภาพ  4.31 การเปดไฟลภาพ Logo 
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11.  ทําการ COPY รูปภาพไปท่ีเคร่ืองมือ   Marquee เลือก Rectangular Marquee   
โดยการลากเมาสครอบรูปท้ังหมด แลวไปท่ีแถบเมนูบาร เลือกคําส่ังEdit > copy > ลากเมาสไปท่ี
พื้นท่ีทํางาน> Edit อีกคร้ังหนึ่ง > Paste รูปโลโกก็จะมาอยูท่ีพื้นท่ีทํางานแลวทําการ ใชเคร่ืองมือ   
Move Tool                      ในการเคล่ือนยายตําแหนงของภาพโดยการนําเมาสมาคลิกคางไวท่ีรูปแลว 
ทําการเคล่ือนยายรูปไดตามความเหมาะสมดังภาพ 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

ภาพ  4.32 การ COPY รูปภาพ 
 

12.  พิมพขอความคร้ังตอไปใหคลิกท่ี Move Tool (V)                             >    Horizontal 
Type Tool (T)                       ทําการพิมพขอความไดตามตองการ 

 
 
 
 
 
 
 
 
 
 
                      ภาพ  4.33  การ  Move Tool ตัวอักษร 
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13.  การใสรูปภาพประกอบ 
14.  เปดไฟลภาพท่ีตองการ ทําการ Rectangular Marquee Tool                  มาครอบภาพ

ท้ังหมดในรูปจะเกิดเสนปะท้ังรูปไปท่ี Move Tool            และกลับมาท่ีภาพอีกคร้ังโดยการคลิก
เมาสคางไวแลวลากมาท่ีพื้นท่ีทํางาน  

 
 

 
 
 
 
 
 
 
 

                             ภาพ  4.34 การใสภาพประกอบ 
 
15. ทําการลบภาพพ้ืนหลังไปท่ี Polygonal lasso tool                     > คลิกเลือกบริเวณท่ีเปน

พื้นหลังของภาพท้ังหมดใหเกิดการ Selection   
 
   
 
 
 
 
 
 
 
 
 
                       ภาพ  4.35 การลบสวนท่ีไมตองการออก 
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16.  เสร็จแลวไปท่ีกลองเคร่ืองมือ เลือก Eraser Tool                           ลบพื้นท้ังหมดจะได
ดังภาพ 

 
 
 
 
 
 
 
 
 
 

                               ภาพ  4.36 แสดงการลบท่ีสมบูรณ 
 

17.  ใสกรอบในรูปท่ีลบเสร็จแลวอีกคร้ังหนึ่ง  เพื่อใหเกดิมิติอีกคร้ังไปท่ี  การ Rectangular 
Marquee Tool                      ลากส่ีเหลียม ใหเทากับกรอบที่เราตองการเสร็จแลวปลอยเมาส 

 
18.  ไปท่ี Layers > วงกลม ภายในมีรูปสามเหลียม > New Layer   

 
 
 
 
 
 
 
 
 
 
 

                           ภาพ  4.37 การสราง Layers ใหม 
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19. ไปท่ีชองเลือกสีและแสดงการใชสี                                      ทําการเลือกสีท่ีตองการ 

 
 
 
 
 
 
 
 
 
 
 

                                 ภาพ   4.38 เลือกสีพื้นภาพ 
 
  20.  เลือกการเทสีแบบ  Gradient Tool โดยการลากเมาสข้ึน หรือลง ก็ไดดังภาพ 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                ภาพ    4.39 การไลสีแบบ Gradient    
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21. เปด File รูป นํามาวางในสวนท่ีเปนพืน้ท่ีวางใหดูสวยงาม 
 

 
 
 
 
 
 
 
 
 
 
 
 

                               ภาพ  4.40 การเพิ่มรูป 
 

22.  ใชเคร่ืองมือ Move Tool                           โดยการลากเมาสไปคลิกดึงภาพมาวางใน
พื้นท่ีทํางานของโปสเตอร ทุกภาพ ใหดูเต็มพื้นท่ีท่ีออกแบบไวใหสวยงาม 
 
 
 
 
 
 
 
 
 
 

                                 ภาพ  4.41 การจัดวางภาพจนสมบูรณ 
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23. ไปท่ี  File > Save As > ต้ังช่ืองาน แลว Save as Type ใหเปนสกุล TIFF 
24. ไดโปสเตอรท่ีสมบูรณแบบพรอมพิมพ 

 
ตัวอยางโปสเตอร 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                             ภาพ  4.42 โปสเตอรทางวิชาการ 
 

โปสเตอรทางวิชาการ ซ่ึงมีตัวอักษรมากควรแบงเปน 2 คอลัมส จัดองคประกอบโดยการแบงเปน 
อักษรกับภาพ เปนสองคอลัมสเทากัน  แลววางภาพดานลาง โดยการจดัเลยเอาทใหดูเทากัน 

 
 
 
 
 
 
 
 
 

                                   ภาพ  4.43 โปสเตอรกีฬา 3 พระจอม 
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โปสเตอรกีฬามีการจัดวางแบบกึ่งกลางใหภาพประกอบเดนชัด สวนอักษรจะบอก
รายละเอียดตางๆ 

 

 
 
 
 
 
 
 
 
 

                                 ภาพ  4.44 โปสเตอร 50 ป 
 
โปสเตอร 50 ป ของพระจอมเกลาลาดกระบังจัดภาพประกอบโดยนํานักศึกษามาเปนแบบ

แลวนํามาจัดวางตามเลข 50 มีอักษรเนนตรงกลาง  สวนอักษรและโลโกจัดแบบ ชิดซายและชิดขวา
และอักษรยอยวางกึ่งกลางลางอีกที 

 
 
 
 
 
 
 
 
 
                                   ภาพ  4.45 โปสเตอรแสดงผลงานทางวิชาการ   
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โปสเตอรแสดงผลงานทางวิชาการ  มีการจัดวางแบบเนนผลงานรูปภาพอยูบนแลวแบงดานลางเปน
สองสวน กําหนดใหรูปอยูดานซายท้ังหมด  และอักษรอยูดานขวาท้ังหมด 
 

เทคนิคการออกแบบปกส่ือส่ิงพิมพ 
 

การออกแบบปกส่ิงพิมพ  เปนการออกแบบท่ีนํารูปภาพและงานกราฟคมาประกอบกัน โดย
ใชหลักการออกแบบ  เร่ืองของจุด เสน สี รูปราง รูปทรง  ในการออกแบบปกหนังสือเราใชท้ัง
ภาพประกอบไดหลายแบบ เชน รูปถาย ( Photograph) ภาพวาด (Illustrate) หรือภาพที่ตกแตงมาจาก
คอมพิวเตอร   ตัวอักษร ขอความ นํามาจัดวางใหไดรูปแบบท่ีเหมาะสมดึงดูดความสนใจ สะดดุตา
เปนท่ีจดจําไดงาย นาอาน นาสนใจ จนอยากหยิบข้ึนมาดู 

ออกแบบปกหนังสือตําราเรียน เปนการออกแบบตามเนื้อหาใหสอดคลองกันกับปกหนังสือ  
ปกหนังสือสวนมากจะเปนรูปแบบของการออกแบบกราฟค  ภาพถาย   หรือภาพวาด เปนสวนใหญ
ปกหนังสือ  ตําราเรียน จะเนนหัวเร่ืองเปนหลัก  สวนรูปภาพประกอบสวนใหญก็นํามาจากเน้ือเร่ือง
ในตําราเรียนนั่นเอง   

 

ตัวอยางปกตําราเรียน 
 
 
 
 
 
 
 
 
 
 
 
 
                                  ปกหนา                                                          ปกหลัง 
                                         ภาพ  4.46 การออกแบบปกตําราเรียน 
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การออกแบบปก  หนังสือ เร่ืองการวิเคราะหเชิงตัวเลข จะเห็นวาช่ือเร่ืองเปนตัวเลข  
ดังนั้นแนวคิดในการออกแบบจึงคิดถึงการนําเอาตัวเลขมาใชในการออกแบบเปนหลัก  นํา
ลายกราฟคมาประกอบเพ่ือใหเกิดมวลสารไมใหตัวเลขดวูางเกนิไป สวนสีสันเปนแบบไล
โทนนํ้าหนกั 

 

ขั้นตอนการปฎิบัตงิาน 

1. เขาสูโปรแกรม Adobe Photoshop   Click Icon        บน Desktop 
2. Click ท่ีเมนู File  
3. คําส่ัง New (Ctrl + N) 
4. เกิดหนาตาง NEW   
5. กําหนดขนาดของปกหนงัสือ Preset Sizes: A4 > Resolution: 300 pixels/inch > Mode: 

CMYK Color > Contents: white > OK 
 
 

 
 
 
 
 
 
 
 
 
 
 

                         ภาพ  4.47 การกําหนดขนาดของปกหนังสือ 
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6. กําหนดสีพื้นท่ีตองการในที่นี้ใชสีฟา เม่ือไดแลวคลิก OK 
 
 
 
 
 
 
 
 
 
 

                       ภาพ  4.48 การเลือกสีพื้นของปกหนังสือ 
 
7.  เทสีพื้นคลิกท่ีชองเลือกสี >   Paint Bucket เทสีลงในพื้นท่ีทํางาน 

 
 
 
 
 
 
 
 
 
 
 
 

                                       ภาพ  4.49 การใสสี 
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8.  กอนพิมพใหไปเลือก Paint Bucket โดยในท่ีนีก้ําหนดใหเปนสีขาว > OK 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                        ภาพ  4.50 เลือกสีเพื่อพิมพอักษร 
 

9.  คลิกท่ีตัว T พิมพหวัขอเร่ืองโดยกําหนดขนาดตัวหนงัสือ 60 pt เลือกรูปแบบตัวอักษร
ตามตองการและพิมพหวัเร่ือง 

 
 
 
 
 
 
 
 
 
 

                                        ภาพ  4.51 แสดงการพิมพหวัเร่ือง 
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10. เปด File ภาพโดยในท่ีนีใ้ชภาพกราฟคนํามาวางในพ้ืนท่ีทํางาน 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                             ภาพ  4.52 เปด File ภาพท่ีตองการมาจดัวาง 
 
11. พิมพตัวเลขคลิกท่ี F ดานลางของพาเล็ตเลเยอร เลือก Drop Shadow สรางเงาคลิกท่ี OK 

จะไดเงาเกดิข้ึน 
 
 
 
 
 
 
 
 
 
 

                                 ภาพ  4.53 การใสเงาตามตัวเลขตาง ๆ  
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12. พิมพช่ือผูแตง สาขา คณะ และสถานศึกษาไวท่ีมุมดานลางของปกหนังสือ 
 
 
 
 
 
 
 
 
 

 
 
 

                                       ภาพ  4.54 การพิมพช่ือผูแตง   
 

13. การสรางกรอบดานลางโดยใชเคร่ืองมือ Polygonal lasso Tool  > Layers > สามเหล่ียมใน 
วงกลม > New Layer > เทสีท่ีเลือกไว > ไปท่ีแถบเมนูบาร > Select > Deselect เสนปะก็จะหายไป 

 
 
 
 
 
 
 
 
 
 
 
 

                                             ภาพ  4.55 การสรางกรอบ 
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14.  ไดปกหนงัสือท่ีสมบูรณ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

                                           ภาพ   4.56 ปกหนังสือท่ีสมบูรณ 
 
ตัวอยางแบบปกส่ือส่ิงพิมพ 

 
 
 
 
 
 
 
 
 

 
 

         ภาพ  4.57  ตัวอยางออกแบบปกรายงานประจําป 
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      ภาพ  4.58  ตัวอยางออกแบบปกงานพิธีถวายผาพระกฐินพระราชทาน 

 
 
 

 
 
 
 
 
 
 
 

 
 

                           ภาพ  4.59  ตัวอยางออกแบบปกมุทิตาจติ 
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                      ภาพ  4.60   ตัวอยางออกแบบปกสูจิบัตร ปกหนา 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

    ภาพ  4.61  ตัวอยางสูจิบัตร ปกหลัง 
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ภาพ  4.62    ตัวอยางออกแบบปกวารสารพระจอมเกลาลาดกระบังสัมพนัธ ป 2550 
 

 
 
 
 
 
 
 
 
 
 
 
           ภาพ  4.63  ตัวอยางออกแบบปกวารสารพระจอมเกลาลาดกระบังสัมพันธ ป 2551 
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          ภาพ  4.64   ตัวอยางออกแบบปกวารสารพระจอมเกลาลาดกระบังสัมพันธ ป 2552 

 
 
 
 
 
 
 
 
 
 
 
 

 ภาพ  4.65  ตัวอยางออกแบบปกวารสารพระจอมเกลาลาดกระบังสัมพนัธ ป  2553 
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เทคนิคการออกแบบแผนพับ ( Folder) 
 

แผนพับ (Folder) เปนส่ือส่ิงพิมพท่ีผลิตโดยเนนการนาํเสนอเนื้อหา ซ่ึงเนื้อหาท่ีนําเสนอ
นั้นเปนเนื้อหา ท่ีสรุปใจความสําคัญ   ส่ือโฆษณาประเภทนี้จดัวาเปนส่ิงพิมพประเภทไดเรกตเมล 
(Direct Mail) ท่ีผูผลิตสงตรงถึงผูบริโภค ท้ังวิธีการสงทางไปรษณียและแจกตามสถานท่ีตางๆ 
ลักษณะเดนของแผนพับคือ มีขนาดเล็ก หยิบงาย ใหขอมูลรายละเอียดไดมากพอสมควร ผูดู
สามารถเลือกเวลาดูไดและคาใชจายในการผลิตตํ่า แผนพับเปนส่ิงพมิพท่ีใชงานมีการกางพับเขา
และกางออก 

 

แบบของการพับแผนพับ 
 

เรามักใชกระดาษ A 4  , A3 ก็ได  มีรูปแบบการพับท่ีไมซับซอนมากนัก  โดยการพับเปน
การพับแบบ  พับ 2 ตอน พับ 3 ตอน หรือ พับ 4 ตอน  นอกจากนี้ยังมีวิธีพับแบบอ่ืน ๆ แลวแตการ
ออกแบบของนักออกแบบวาจะมีการออกแบบการพับแบบใด เชน พบักลาง  พับหกหนา  พับมุม
ฉาก  พับหีบเพลงชัก  พับขนาน    
 

สวนประกอบของแผนพับ 
 

 1.ปกหนา  สวนประกอบตาง ๆ ท่ีจะตองไดรับการออกแบบและจัดวาง
องคประกอบในปกหนาของแผนพับ ไดแก 

    1.1 พาดหวั คือ ขอความหลักท่ีใชเรียกรองความสนใจจากผูพบเหน็ 
    1.2  ภาพในปกหนา คือ  ภาพท่ีใชเรียกรองความสนใจจากผูพบเหน็ 
    1.3  ขอความบนปก คือ  ขอความท่ีใชระบุประเด็นสําคัญ 
    1.4   ตราสัญลักษณ  คือ ส่ิงท่ีระบุผูเปนเจาของแผนพับ 

ท้ังนี้ในปกหนาของแผนพับไมจําเปนตองมีองคประกอบครบท้ัง 4 องคประกอบ 
 

2.หนาใน  สวนประกอบตาง ๆ ท่ีจะตองไดรับการออกแบบและจัดวาง
องคประกอบในหนาในของแผนพับ ไดแก 

     2.1  เนื้อหา คือ ขอความท่ีใชบอกเลาขอมูล หรือองคกรผูเปนเจาของแผนพับ 
นั้น 

      2.2  ภาพในหนาใน คือ ภาพท่ีใชสงเสริมเนื้อหา หรือขยายจินตนาการของ 
ผูอานใหเขาใจ 

      2.3  องคประกอบเรขศิลปอ่ืน ๆ คือ ส่ิงท่ีใชสงเสริมเนื้อหาใหเขาใจงายข้ึน 
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 3. ปกหลัง  สวนประกอบตาง ๆ ท่ีจะตองไดรับการออกแบบและจัดวาง 
องคประกอบในปกหลังของแผนพับ ไดแก 

      3.1  เนื้อหา คือ ขอความท่ีใชระบุองคกร วาช่ืออะไร 
     3.2   ภาพในปกหลัง คือ ภาพตราสัญลักษณ คือ ส่ิงท่ีใชระบุผูเปนเจาของแผน 

                                        พับนั้น 
    3.3  องคประกอบเรขศิลปอ่ืน ๆ คือ ส่ิงท่ีใชระบุองคกร เชน แผนท่ีสถานท่ีต้ัง 

                                       องคกร  
  (อารยะ  ศรีกัลยาณบุตร  2550, หนาท่ี 275-276) 
 

ขั้นตอนการปฎิบัตงิาน 

1. เขาสูโปรแกรม Adobe Photoshop   Click Icon        บน Desktop 
2. Click ท่ีเมนู File  
3. คําส่ัง New (Ctrl + N) 
4. เกิดหนาตาง NEW   
5.กําหนดขนาด 
  
 

 
 
 
 
 
 
 
 

                                             ภาพ  4.66 กําหนดขนาด    
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1. ทําการใสสีพื้น โดยการเลือกหมวดสีในท่ีนี้เปนสีน้ําเงิน Gradient Tool 
 
 
 
 
 
 
 
 
 
 

                                
                                  ภาพ  4.67 ใสสีพื้นแบบ Gradient Tool 

 
 7. คลิก T พิมพตัวอักษรช่ือสถาบัน 
 
 

 
 
 
 
 
 

 
 

 
                            
 
                                             ภาพ  4.68 พิมพตัวอักษร 
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8. เปด File ภาพท่ีตองการทําปกหนาแผนพบั 
 
 
 
 
 
 
 
 
 
 
 

 
                                       ภาพ  4.69 เปด File ภาพ 

 
9. ไปท่ี Magic ทําการลบบริเวณรอบตัวตึกใหเหลือแตตัวตึก 
 
 
 
 
 
 
 
 
 
 
 
 

 
                               ภาพ  4.70 การใช Magic ลบบริเวณพืน้หลัง 
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10.  พอไดภาพท่ีตองการแลวทําการยายภาพไปใสในพื้นท่ีเราเตรียมไว 
 
 
 
 
 
 
 
 
 
 
 

 
                                               ภาพ  4.71 ภาพท่ีลบแลว 
 
11. วิธีใสเงาโดยไปท่ี f ใน Layers ไปท่ี Drop Shadow แลวเลือกขนาดของเงาตามตองการ

และคลิก OK  
 
 
 
 
 
 
 
 
 
 
 

 
                                                ภาพ  4.72 การใสเงา 
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12.  ไปท่ี File  > Save as ต้ังช่ือในท่ีนี้ “ปกแผนพับ 1” เลือกนามสกุล PSD > Save 
 
 
 
 
 
 
 
 
 
 
 
                                                   ภาพ  4.73 การ Save 

 
13. การทําหัวขอเร่ืองไปท่ี File > new > กาํหนดขนาด > OK 
14.  เลือกสี > Gradient Tool  
 
 
 
 
 
 
 
 
                                 ภาพ  4.74 การใสสีแบบ Gradient Tool 
 

 15.  คลิก T พิมพตัวอักษร โดยการสรางเงา > f ใน Layer > Drop Shadow > เลือกขนาด
ของเงาตามตองการ > OK  
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16.  ไปท่ี File > Save as ต้ังช่ือ >เลือกนามสกุล PSD > Save 
 
 
 
 
 
                                         ภาพ  4.75   Save as ต้ังช่ือ 
 
17.  เปดโปรแกรม Illustrator > File > new กําหนดขนาดพื้นท่ี 
 
 
 
 
 
 
 
                              ภาพ  4.76 พื้นท่ีทํางานในโปรแกรม Illustrator 

 
18.  คลิก File > place > เลือกปกแผนพับ 1 > place > OK 
 
 
 
 
 
 
 
 

 
 
                                           ภาพ  4.77 วิธีเปด File ภาพ 
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19.   ไปท่ี Selection ทําการหมุนภาพโดยวางในตําแหนงท่ีตองการ 
 
 
 
 
 
 
 
 
 
 
 
 

 
                                         ภาพ  4.78 การหมุนภาพ 
 
20. คลิกท่ี T พมิพขอความ 
21.  นํารูปภาพมาวางพรอมกับหัวขอเร่ืองโดยการไปท่ี File > place > เลือกรูปมาวางตาม

ตําแหนงตาง ๆ  
 
 
 
 
 
 
 
 
 

 
                                                 ภาพ  4.79 พิมพขอความ 
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22.  ไดปกหนาพรอมปกหลังของแผนพับท่ีสมบูรณ File > Save as > ต้ังช่ือจะไดนามสกุล 
Al > Save > OK 

 
 
 
 
 
 
 
 
 
 
 

 
                                       ภาพ 4.80   แผนพบัท่ีสมบูรณ 
 
23. การทําปกสวนใน เปด File > new > กําหนดขนาด > ใสสีพื้น 
24. พิมพขอความ 
 
 
 
 
 
 
 
 
 
 

 
                              ภาพ 4.81  การใสขอความในแผนพับ 
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25. คลิก File > place > เลือกรูปภาพ 
 
 
 
 
 
 
 
 
 
 
 
                            ภาพ 4.82  นํารูปภาพมาวางในตําแหนงท่ีตองการ 
 
26. นํารูปภาพท่ีตองการมาวาง 
27.  จะไดสวนในของแผนพับท่ีสมบูรณ File > Save as > ต้ังช่ือ “ปกใน” > Save จะได 

นามสกุล Al พรอมสงพิมพ 
 
 
 

 
 
 
 

 
 
 
 
                               ภาพ 4.83  สวนในของแผนพับท่ีสมบูรณ 
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ตัวอยางแผนพับ 
 
 
 
 
 
 
 
 
 
 
 
 

                                                ภาพ  4.84    แผนพับดานหนา   

 
 
 
 
 
 
 
 
 
 
 

                                         ภาพ  4.85  แผนพับดานหลัง 
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                                                            ภาพ  4.86 แผนพับดานหนา 
 

 
 
 
 
 
 
 
 
 
 
 
 

                                   ภาพ  4.87  แผนพับดานหลัง 
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บัตรอวยพร 
 

ส.ค.ส. ยอมาจาก สงความสุขปใหม ลักษณะเปนบัตรอวยพรที่สงใหกันเนื่องในโอกาสวัน
ข้ึนปใหมสมัยกอนชาวไทยนิยมสงถึงกันเปนจํานวนมาก ทําใหในชวงปใหมไปรษณยี จะตองมี
ภาระของการสง ส.ค.ส. จํานวนมาก ในสถาบันเทคโนโลยีพระจอมเกลาเจาคุณทหารลาดกระบัง 
โดยผูบริหารหนัมาใชเทคโนโลยีในการสง ส.ค.ส.ใหแกบุคลากรในสถาบันดวยการสงทางอีเมล    
ปจจุบันเร่ิมมีการสง ส.ค.ส.อิเล็คทรอนิคส ทางอินเทอรเน็ตกนับางเพื่อเปนการลดมลพิษและ
ทรัพยากรธรรมชาติ เชน ตนไม  

ปจจุบันในแตละปพระบาทสมเด็จพระเจาอยูหวัภูมิพลอดุลยเดช จะทรงมอบส.ค.ส. 
พระราชทานใหกับชาวไทยท้ังประเทศ 

 

ขั้นตอนการปฎิบัตงิาน 

1. เขาสูโปรแกรม Adobe Photoshop   Click Icon        บน Desktop 
2. Click ท่ีเมนู File  
3. คําส่ัง New (Ctrl + N) 
4. เกิดหนาตาง NEW > เพื่อกาํหนดขนาดของบัตรอวยพร > คลิกท่ี OK 

 

 
 
 
 
 
 
 
 
 

                                      ภาพ  4.88 หนาตางการทํางานใหม 
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5.  เลือกรูปภาพท่ีจะมาทําเปน บัตรอวยพร 
 
 
 
 
 
 
 
 
 
 

                                  ภาพ  4.89 เปดไฟลรูปพระ 

 
6. ไปท่ีกลองเคร่ืองมือคลิก Magic Wand > Shift ท่ีแปนคียบอรดคางไว 

 
 
 
 
 
 
 
 
 
 
 
 

                                       ภาพ  4.90 การใช Magic Wand 
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 7. คลิก Eraser Tool > เลือกขนาดของ Brush เพื่อลบพื้นท่ีดานหลังของภาพ 

 
 
 
 
 
 
 
 
 
 
 
 

                                          ภาพ  4.91 การปรับ ขนาดของ Brush 

 
 8. ไปท่ีแถบเมนูบารเลือก  Select > Deselect เสนปะก็จะหายไป คลิกเมาสท่ี Eraser Tool 
เพื่อลบบริเวณรอบนอกของภาพ 

 
 
 
 
 
 
 
 
 

                             ภาพ  4.92 การลบบริเวณรอบนอกของภาพ 
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 9.  เม่ือลบบริเวณพืน้หลังหมดแลวภาพพื้นหลังจะเปนสีขาว และไปท่ี Eraser Tool > 
Magic Eraser Tool 

 
 
 
 
 
 
 
 
 
 
 

                          ภาพ  4.93 การใช Magic Eraser Tool ในการลบ 

 
 10.  ทําพื้นหลังภาพโดยการเลือกสีโดยไปที่ Set foreground color 
 

 
 
 
 
 
 
 
 
 

ภาพ  4.94 การลบพื้นหลัง 
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 11. ไปท่ี Layer >                     > new Layer ก็จะเกิด Layerใหม และคลิก OK  

     
 
 
 
 
 
 
 
 
 

 
ภาพ  4.95 การสราง   new Layer 

 
12. ไปท่ี Paint Bucket Tool  

 
 
 
 
 
 
 
 
 
 
 

 
ภาพ  4.96 การใสสีพื้น 
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13. ใหนํา Layer 1 วางบน  Layer 2   

 
 
 
 
 
 
 
 
 
 

 
 

ภาพ  4.97 การยาย Layer 1 วางบน  Layer 2 

 
14. ไปท่ี Move Tool แลวลากพื้นไปวางท่ีพื้นท่ีทํางาน > Edit > Transform > Seale ทําการ

ยอขยายใหไดคร่ึงของแผนกระดาษ บัตรอวยพร 

 
 
 
 
 
 
 
 

 
ภาพ  4.98 การยอขยาย 
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 15.  ไปท่ี File ภาพไปใชเคร่ืองมือ Move Tool                 คลิกเมาสลากตัวของรูปพระไป
วางในสวนของสีแดงและทําการยอภาพใหไดขนาดท่ีตองการแลวกด Enter   

 
 
 
 
 
 
 
 

 
ภาพ  4.99 การยายดวยเคร่ืองมือ Move Tool 

 

 
16. พิมพขอความไปท่ี                      พิมพขอความตามแบบท่ีกําหนด       

 
 
 
 
 
 
 
 
 
 
 

ภาพ  4.100 พิมพขอความตามแบบท่ีกําหนด 
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17. เปด File ภาพลวดลายนํามาวางตามมุมภาพใหสวยงาม 
18.ไปท่ี  File  > Save As > ต้ังช่ืองาน แลว Save As Type ใหเปนสกุล GPJ 
19. เปนบัตรอวยพร ท่ีสมบูรณแบบพรอมพิมพหรือนําไปข้ึนเว็บ 

 
 
 
 
 
 
 
 
 
 
 
 

ภาพ  4.101 บัตรอวยพรรูปพระ 
 
ตัวอยาง บัตรอวยพร 

 
 
 
 
 
 
 
 
 
 

ภาพ  4.102  บัตรอวยพรรูป รัชกาลท่ี 4 
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การแตงรูปภาพดวยคอมพิวเตอรกราฟค 
 

การแตงภาพดวยคอมพวิเตอรกราฟค  เปนโปรแกรมหนึ่งท่ีชวยในการแกไขปรับแตงภาพ 
โดยเฉพาะภาพถายท่ีถายดวยกลองดิจิตอลในปจจุบันนยิมใชกันมากในหมูนกัออกแบบกราฟค นกั
ออกแบบส่ือส่ิงพิมพ  รานถายรูปมีความสําคัญในการแตงภาพโดยสวนใหญมักนยิมใชในการจดัทํา
ส่ือส่ิงพิมพคูกับโปรแกรม อโดบี เพจเมกเกอร (Adobe PageMaker) ท่ีนิยมใชในปจจุบันนอกจาก 
Photoshop, PageMaker แลว ยังมี Adobe Acrobat, Adobe Illustrator, Adobe Type Manager , DM 
Portrait Pro 4.0  เปนตน 

 

ขั้นตอนการปฎิบัตงิาน 
 

1. นําภาพท่ีถายดวยกลองดิจิตอลท่ีเปน File นามสกุล jpg ท่ีมีขนาด 3872*2592 /10.0 M  

             2. เขาสูโปรแกรม Adobe Photoshop   Click Icon        บน Desktop 
 

3. Click ท่ีเมนู File > Open  เปด File รูป เลือกรูปท่ีจะตองการแตงภาพ หรือ รีทัชภาพ 
 
 
 
 
 
 
 
 
 
 

 
 
 

ภาพ  4.103 การเลือกรูปภาพท่ีจะแตง 
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4.  เม่ือไดรูปภาพท่ีตองการแลวมาท่ีกลองเคร่ืองมือโดยใช ZoomTool                        เพื่อท่ีจะ
ขยายภาพทําการลบสวนท่ีตองการจะลบ เชน สิว  ร้ิวรอยใตตา ฯลฯ 

 
 
 
 
 
 
 
 
 
 
 

ภาพ  4.104 การขยายภาพ โดยใช ZoomTool 
 

5. ไปท่ี Healing Brush Tool                       พรอมกับกด Alt ท่ีแปนคียบอดลคางไวแลว
ปลอย Alt คลิกสวนท่ีลบบริเวณใตตาจะเหน็ไดวาร้ิวรอยใตตาหายไป 

 
 
 
 
 
 
 
 
 
 
 

ภาพ  4.105 การใช Healing Brush Tool 
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6. ไปท่ีกลองเคร่ืองมือโดยใช Hand Tool                           เล่ือนไปลบอีกขางหนึ่งในสวนท่ี
ตองการจะลบโดยทําการลบไปเร่ือย ๆ ตามบริเวณท่ีตองการจนกวาจะไดภาพท่ีพอใจ 

 
 

 
 
 
 
 
 
 
 

 
ภาพ  4.106 การเคล่ือนยายเภาพโดยใช Hand Tool 

 
7.  ใชเคร่ืองมือ  Blur Tool                          ลบบริเวณรอบใบหนายกเวน ตา และปาก 

เพื่อใหผิวหนาเนียน 

 
 
 
 
 
 
 
 
 
 

ภาพ  4.107 การเลือกใชเคร่ืองมือ Blur Tool 
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8.  ใชเคร่ืองมือ Blur Tool โดยเลือกขนาดของ Blur Tool ใหพอดีกับสวนท่ีจะลบ 

 
 
 
 
 
 
 
 
 
 
 

ภาพ  4.108 เลือกขนาดของ Blur Tool 

 
9.  จะไดภาพท่ีมีใบหนาท่ีเนียนในระดับหนึ่ง 

 
 
 
 
 
 
 
 

 
 
 

ภาพ  4.109 ภาพท่ีมีใบหนาท่ีเนียนในระดบัหนึ่ง 
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 10. ทําการ Save As โดยการต้ังช่ือ Fileรูป ในท่ีนี้สมมุติใหเปนช่ือ AA1 นามสกุล JPEG 

 
 
 
 
 
 
 
 
 
 
 
 

ภาพ  4.110 โฟลเดอร หนาตาง Save As 

 
11.  เขาสูโปรแกรมแตงภาพสําเร็จรูป (DM Portrait 4.0 )  ซ่ึงเปนโปรแกรมสําเร็จอีก

โปรแกรมหนึง่ท่ีนิยมใชกันมากในสตูดิโอและรานถายภาพ 

 
 
 
 
 
 
 
 

 
ภาพ  4.111 หนาตางโปรแกรม DM Portrait 4.0 
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 12.  ไปท่ีไฟล > เปด คลิกไฟลรูป AA1  

 
 
 
 
 
 
 
 
 
 
 
 

ภาพ  4.112 เปดไฟลรูป 

 
13.  เลือกอัตโนมัติท่ีไอคอนหนาคน                       ตรงแถบเมนูบารแลวเลือกผิวเกล่ีย  เม็ด

ผิว 2.7  ความกลมกลืน 15 ไปคลิกท่ีข้ันตอนท่ี 2  และ ข้ันตอนท่ี 3 ไดเลย 
 

 
 
 
 
 
 
 
 
 

ภาพ  4.113 เลือกผิวเกล่ีย 
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14.  การเปล่ียนเส้ือไปท่ีปรับภาพ  > ใสชุดขาราชการ 

 
 
 
 
 
 
 
 
 
 
 

ภาพ  4.114  เลือกใสชุดขาราชการ 
 

 15. เลือกเพศ > กระทรวง >แบบแสง > ขาราชการระดับ > ขนาดภาพ > แถบ > 
เคร่ืองราชอิสริยาภรณ ในท่ีนีเ้ลือก ชาย > กระทรวงศึกษาธิการ > แสงตรง > ขาราชการระดับ 8 > 
เคร่ืองราชอิสริยาภรณ ท.ช ทม. > 8*10 > ตกลง  

 
 
 
 
 
 
 
 
 
 

ภาพ  4.115 เลือกเคร่ืองแบบในสังกัด 
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16.จะไดภาพใสชุดขาราชการแตงตองมีการยอขยายภาพเพื่อใหเขากับชุดขาราชการที่
สมบูรณ 

 
 
 
 
 
 
 
 
 
 
 

ภาพ  4.116 ภาพใสชุดขาราชการ 

 
17. ไดภาพท่ีสมบูรณ ในโปรแกรม DM Portrait 4.0 

 
 
 
 
 
 
 
 

 
 

ภาพ  4.117  ภาพท่ีแตงเสร็จแลวในโปรแกรม  DM Portrait 4.0 
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 18. เสร็จแลวไปเลือกคําส่ังไฟล  > ท่ีสงออก > สงไป Photoshop  
 

 
 
 
 
 
 
 
 
 

 
ภาพ  4.118 การสงไฟลรูปไปโปรแกรม Photoshop 

 
19.  ภาพก็จะสงมาปรากฎอยูในโปรแกรม Photoshop ถาไมมีการแกไขก็ให Save As ต้ังช่ือ

ใหมในท่ีนี้ใหเปน AA2 นามสกุล JPEG  

 
 
 

 
 
 
 
 
 
 

ภาพ  4.119 ภาพท่ีแตงใน Photoshop อีกคร้ังเปนการตัดสวนท่ีไมตองการออก 
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20.   เปรียบเทียบการแตงภาพกอนและหลังแตงภาพจะไดภาพดังภาพตัวอยางขางลางนี้ 

 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพ  4.120 เปรียบเทียบการแตงภาพกอนและหลังแตงภาพ 

 
21. ไปท่ีไฟล > เปด คลิกไฟลรูป AA1 เพื่อเปล่ียนแบบเส้ือใสสูท 

 
 
 
 
 
 
 
 
 

                                                         ภาพ  4.121 เปดไฟลรูป 
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22.  เลือกอัตโนมัติท่ีไอคอนหนาคน                       ตรงแถบเมนูบารแลวเลือกผิวเกล่ีย  เม็ด
ผิว 2.7  ความกลมกลืน 15 ไปคลิกท่ีข้ันตอนท่ี 2  และ ข้ันตอนท่ี 3 ไดเลย 

 

 
 
 
 
 
 
 
 
 
 
 
 
                         ภาพ  4.122 เลือกผิวเกล่ีย ทําหนาเนยีน 

 
23.  การเปล่ียนเส้ือไปท่ีปรับภาพ  > ใสชุดสูท > เลือกเปล่ียนเส้ือนอก  

 
 
 
 
 
 
 
 

ภาพ  4.123 ข้ันตอนการเลือกสูท 
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24.  เลือกสูทท่ีตองการ 

 
 
 
 
 
 
 
 
 
 
 
 

ภาพ  4.124 เลือกสูท 

 
25.  จะไดภาพเส้ือสูทมาบังภาพเดิม เส้ือสูทท่ีไดมาจะมีขนาดท่ีเล็กกวาตองมีการยอขยาย

ภาพเพื่อใหพอดีกับคอเส้ือ 
 
 
 
 
 
 
 
 
 
 

ภาพ  4.125 ไดภาพเส้ือสูท 
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26. ไดภาพท่ีใสเส้ือสูทท่ีสมบูรณ 
 

 
 
 
 
 
 
 
 
 
 
 
 

ภาพ  4.126 รูปใสเส้ือสูท 
 

27.  เสร็จแลวไปเลือกคําส่ังไฟล  > ท่ีสงออก > สงไป Photoshop  

 
 
 
 
 
 
 
 
 
 
 
 

ภาพ  4.127 รูปท่ีแตงเสร็จสมบูรณ 
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28.  ภาพก็จะสงมาปรากฎอยูในโปรแกรม Photoshop ถาไมมีการแกไขก็ให Save As ต้ังช่ือ
ใหม  นามสกุล JPEG   

29.  เปรียบเทียบ รูป ท้ัง 3รูป 
 
 
 
 
 
 
 
 
 
 
 

 
ภาพ 4.128 การเปรียบเทียบรูปกอนแตงและหลังแตง 

 
สรุปหนังสือเทคนิคการออกแบบส่ือประชาสัมพันธดวยคอมพิวเตอร เลมนี้เปนเพียงการ

แนะนําเทคนิคท่ีใชคอมพิวเตอรกราฟคเพื่อการทํางานดานส่ือส่ิงพิมพและการตกแตงภาพมาพอ
สังเขป  ถาตองการเทคนิคท่ีมากกวานี้ขอแนะนําใหไปศึกษาไดจากหนังสือ โปรแกรม Illustrator 
และหนังสือโปรแกรม Photoshop หรือผูท่ีทํางานดานส่ิงพิมพเพิ่มเติมเพื่อท่ีจะไดทํางานใหมี
ประสิทธิภาพมากข้ึน 
 

 
 
 
 


